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Business Analytics, 3e (Evans) 
Chapter 1:   Introduction to Business Analytics 
 
1) Descriptive analytics: 
A) can predict risk and find relationships in data not readily apparent with traditional analyses. 
B) helps companies classify their customers into segments to develop specific marketing 
campaigns. 
C) helps detect hidden patterns in large quantities of data to group data into sets to predict 
behavior. 
D) can use mathematical techniques with optimization to make decisions that take into account 
the uncertainty in the data. 
Answer:  B 
Diff: 1 
Blooms:  Remember 
Topic:  Descriptive, Predictive, and Prescriptive Analytics 
LO1: Illustrate examples of descriptive, predictive, and prescriptive analytics.  
 
 
2) A manager at Gampco Inc. wishes to know the company's revenue and profit in its previous 
quarter. Which of the following business analytics will help the manager? 
A) prescriptive analytics 
B) normative analytics 
C) descriptive analytics 
D) predictive analytics 
Answer:  C 
Diff: 1 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Descriptive, Predictive, and Prescriptive Analytics 
LO1:  Explain the difference between descriptive, predictive, and prescriptive analytics. 
 
 
3) Predictive analytics: 
A) summarizes data into meaningful charts and reports that can be standardized or customized. 
B) identifies the best alternatives to minimize or maximize an objective. 
C) uses data to determine a course of action to be executed in a given situation. 
D) detects patterns in historical data and extrapolates them forward in time. 
Answer:  D 
Diff: 2 
Blooms:  Remember 
Topic:  Descriptive, Predictive, and Prescriptive Analytics 
LO1: Illustrate examples of descriptive, predictive, and prescriptive analytics. 
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4) A trader who wants to predict short-term movements in stock prices is likely to use ________ 
analytics. 
A) predictive 
B) descriptive 
C) normative 
D) prescriptive 
Answer:  A 
Diff: 1 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Descriptive, Predictive, and Prescriptive Analytics 
LO1:  Explain the difference between descriptive, predictive, and prescriptive analytics. 
 
 
5) Which of the following questions will prescriptive analytics help a company address? 
A) How many and what types of complaints did they resolve? 
B) What is the best way of shipping goods from their factories to minimize costs? 
C) What do they expect to pay for fuel over the next several months? 
D) What will happen if demand falls by 10% or if supplier prices go up 5%? 
Answer:  B 
Diff: 2 
Blooms:  Understand 
AACSB:  Analytic Skills 
Topic:  Descriptive, Predictive, and Prescriptive Analytics 
LO1: Illustrate examples of descriptive, predictive, and prescriptive analytics. 
 
 
6) The demand for coffee beans over a period of three months has been represented in the form 
of an L-shaped curve. Which form of model was used here? 
A) mathematical model 
B) visual model 
C) kinesthetic (tactile) model 
D) verbal model 
Answer:  B 
Diff: 1 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Explain the concept of a model and various ways a model can be characterized. 
 
 
7) Decision variables: 
A) cannot be directly controlled by the decision maker. 
B) are assumed to be constant. 
C) are always uncertain. 
D) can be selected at the discretion of the decision maker. 
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Answer:  D 
Diff: 2 
Blooms:  Understand 
Topic:  Models in Business Analytics 
LO1:  Define and list the elements of a decision model. 
 
8) Identify the uncontrollable variable from the following inputs of a decision model. 
A) investment returns 
B) machine capacities 
C) staffing levels 
D) intercity distances 
Answer:  A 
Diff: 1 
Blooms:  Apply 
Topic:  Models in Business Analytics 
LO1:  Define and list the elements of a decision model. 
 
 
9) Which of the following inputs of a decision model is an example of data? 
A) estimated consumer demand 
B) inflation rates 
C) costs 
D) investment allocations 
Answer:  C 
Diff: 1 
Blooms:  Remember 
Topic:  Data for Business Analytics 
LO1:  Define and list the elements of a decision model. 
 
 
10) Descriptive decision models: 
A) aim to predict what will happen in the future. 
B) describe relationships but do not tell a manager what to do. 
C) help analyze the risks associated with various decisions. 
D) do not facilitate evaluation of different decisions. 
Answer:  B 
Diff: 2 
Blooms:  Understand 
Topic:  Models in Business Analytics 
LO1:  Explain the concept of a model and various ways a model can be characterized. 
 
 
11) Prescriptive decision models help: 
A) make predictions of how demand is influenced by price. 
B) make trade-offs between greater rewards and risks of potential losses. 
C) decision makers identify the best solution to decision problems. 
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D) describe relationships and influence of various elements in the model. 
Answer:  C 
Diff: 1 
Blooms:  Remember 
Topic:  Models in Business Analytics 
LO1:  Define the terms optimization, objective function, and optimal solution. 
 
 
12) The manager at Soul Walk Inc., a shoe manufacturing company, wants to set a new price (P) 
for a shoe model to maximize total profit. The demand (D) as a function of price is represented 
as: 
D = 1,500 - 2.5P 
The total cost (C) as a function of demand is represented as: 
C = 3,200 + 3.5D 
Which of the following is a model for total profit as a function of price? 
A) (1,508.75× price) - (2.5 × price2) - 8,450 
B) (3.5 × price2) + 3,200 - (1925.50 × price) 
C) (1,250 × price) + (5 × price2) - 8,320 
D) [4521 + (4.5 × price)] × price - 9684.25 
Answer:  A 
Diff: 3 
Blooms:  Apply 
Topic:  Models in Business Analytics 
LO1:  Define the terms optimization, objective function, and optimal solution. 
 
 
13) Which decision model incorporates the process of optimization? 
A) predictive 
B) prescriptive 
C) descriptive 
D) normative 
Answer:  B 
Diff: 1 
Blooms:  Remember 
Topic:  Models in Business Analytics 
LO1:  Define the terms optimization, objective function, and optimal solution. 
 
 
14) Which of the following is the first phase in problem solving? 
A) defining the problem 
B) analyzing the problem 
C) recognizing the problem 
D) structuring the problem 
Answer:  C 
Diff: 1 
Blooms:  Remember 
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Topic:  Problem Solving and Decision Making 
LO1:  List and explain the steps in the problem-solving process. 
 
 
15) Middle managers in operations: 
A) develop staffing plans. 
B) determine product mix. 
C) develop advertising plans. 
D) make pricing decisions. 
Answer:  A 
Diff: 1 
Blooms:  Remember 
Topic:  Problem Solving and Decision Making 
LO1:  List and explain the steps in the problem-solving process. 
 
 
16) The product mix is determined by the: 
A) accounting staff. 
B) middle managers. 
C) finance managers. 
D) top managers. 
Answer:  D 
Diff: 1 
Blooms:  Remember 
Topic:  Problem Solving and Decision Making 
LO1:  List and explain the steps in the problem-solving process. 
 
 
17) During which phase in problem solving is a formal model often developed? 
A) analyzing the problem 
B) structuring the problem 
C) defining the problem 
D) implementing the solution 
Answer:  B 
Diff: 1 
Blooms:  Remember 
Topic:  Problem Solving and Decision Making 
LO1:  List and explain the steps in the problem-solving process. 
 
 
18) Which of the following is true about problem solving? 
A) Recognizing problems involves stating goals and objectives. 
B) Analyzing the problem involves characterizing the possible decisions. 
C) Decision making involves translating the results of the model in the organization. 
D) Structuring the problem involves identifying constraints. 
Answer:  D 
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Diff: 2 
Blooms:  Understand 
Topic:  Problem Solving and Decision Making 
LO1:  List and explain the steps in the problem-solving process. 
 
 
 
The manager at Goody Woods Inc., a manufacturer of wooden utensil sets, has observed that 
when the company sells its sets at $240, 1,540 units are sold, and when the price is raised to 
$320, demand falls to 1,220 units. Use this information to answer the following two questions. 
 
19) Develop a linear model relating the demand for Goody Woods' units to the price. 
Answer:  Economic theory tells us that demand for a product is negatively related to its price. 
The linear model to predict demand as a function of price is: 
D = a - bP 
where D is the quantity demanded, P is the unit price, a is a constant that estimates the demand 
when the price is zero, and b is the slope of the demand function. 
 
Substituting the values given in the data: 
1,540 = a - (b × 240) 
1,220 = a - (b × 320) 
 
By solving the two equations, values of a and b can be found. 
a = 2,500, which indicates the demand for wood units when price is zero, 
b = 4, which is the slope of the demand function. 
 
Substituting values of a and b in the linear demand prediction model: 
D = 2,500 - 4P 
Diff: 3 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Predictive Spreadsheet Models. 
LO1:  Build spreadsheet models for descriptive, predictive, and prescriptive applications. 
 
 
20) Develop a prescriptive model that will help Goody Woods identify the price that maximizes 
the total revenue. 
Answer:  Having found out the model for demand as a function of price, sales (S) can be 
expressed as: 
S = 2,500 - 4P 
 
Revenue (R) = Sales x Price = (2,500 - 4P) × P = 2,500P - 4P2 
 
Thus, Goody Woods Inc. can identify the price that maximizes the total revenue using: 
R = 2,500P - 4P2 
Diff: 3 
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Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Define the terms optimization, objective function, and optimal solution. 
 
 
21) Decision support systems evolved from efforts to improve military operations prior to and 
during World War II. 
Answer:  FALSE 
Diff: 1 
Blooms:  Remember 
Topic:  Evolution of Business Analytics 
LO1:  Summarize the evolution of business analytics and explain the concepts of business 
intelligence, operations research and management science, and decision support systems. 
 
 
22) A deterministic model is one in which all model input information is either known or 
assumed to be known with certainty. 
Answer:  TRUE 
Diff: 1 
Blooms:  Remember 
Topic:  Models in Business Analytics 
LO1:  Explain the difference between a deterministic and stochastic decision model. 
 
 
23) The complexity of a problem increases when the problem belongs to an individual rather 
than a group. 
Answer:  FALSE 
Diff: 1 
Blooms:  Remember 
Topic:  Problem Solving and Decision Making 
LO1:  List and explain the steps in the problem-solving process. 
 
 
24) A goal of Korel & Marke, a dot-com company, is to gain strategic advantage over its rival 
firms. How can Korel & Marke use analytics and exploit social media to accomplish this goal? 
Answer:  Analytics is helping businesses learn from social media and exploit social media data 
for strategic advantage. Using analytics, Korel & Marke can integrate social media data with 
traditional data sources such as customer surveys, focus groups, and sales data. It can also 
understand trends and customer perceptions of its products; and create informative reports to 
assist its marketing managers and product designers. 
Diff: 2 
Blooms:  Understand 
Topic:  What is Business Analytics? 
LO1:  State some typical examples of business applications in which analytics would be 
beneficial. 
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25) What are the three components of decision support systems (DSS)? 
Answer:  DSSs include three components: 
Data management - The data management component includes databases for storing data and 
allows the user to input, retrieve, update, and manipulate data. 
Model management - The model management component consists of various statistical tools and 
management science models and allows the user to easily build, manipulate, analyze, and  
Communication system - The communication system component provides the interface 
necessary for the user to interact with the data and model management components. 
Diff: 2 
Blooms:  Remember 
Topic:  Evolution of Business Analytics 
LO1:  Summarize the evolution of business analytics and explain the concepts of business 
intelligence, operations research and management science, and decision support systems. 
 
 
26) Explain how data are used by accountants, economists, and operations managers. 
Answer:  Following are the ways data are used: 
Accountants conduct audits to determine whether figures reported on a firm's balance sheet fairly 
represent the actual data by examining samples (that is, subsets) of accounting data, such  
Economists use data to help companies understand and predict population trends, interest rates, 
industry performance, consumer spending, and international trade. 
Operations managers use data on production performance, manufacturing quality, delivery times, 
order accuracy, supplier performance, productivity, costs, and environmental compliance to 
manage their operations. 
Diff: 2 
Blooms:  Remember 
Topic:  Data for Business Analytics 
LO1:  State examples of how data are used in business. 
 
 
27) Data used in business analytics need to be reliable and valid. Explain. 
Answer:  Sample data do not always reflect reality. People do not always behave the same when 
observed, nor do they always act as they say they act. Poor data can result in poor decisions. 
Hence, care must be taken when working with data, and every effort should be made to ensure 
that data are sufficiently accurate. 
Diff: 2 
Blooms:  Remember 
Topic:  Data for Business Analytics 
LO1:  State examples of how data are used in business. 
 
 
28) Why do predictive decision models incorporate uncertainty? 
Answer:  The future is always uncertain. Uncertainty is imperfect knowledge of what will 
happen; risk is associated with the consequences of what actually happens. Even though 
uncertainty may exist, there may be no risk. However, risk is an outcome of uncertainty, though 
not always. Thus, many predictive models incorporate uncertainty and help decision makers 
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analyze the risks associated with their decisions. 
Diff: 2 
Blooms:  Understand 
Topic:  Models in Business Analytics 
LO1:  Explain the difference between uncertainty and risk. 
 
29) Which of the following is not a challenge faced by organizations that want to develop 
analytics capabilities? 
A) a lack of understanding of how to use analytics. 
B) competing business priorities. 
C) understanding benefits versus perceived costs of analytics studies. 
D) difficulty in getting good data and sharing information. 
Answer:  C 
Diff: 1 
Blooms:  Remember 
Topic:  What is Business Analytics? 
LO1: Explain why analytics is important in today’s business environment. 

 
30) Prescriptive analytics: 
A) summarizes data into meaningful charts and reports that can be standardized or customized. 
B) identifies patterns and relationships existing in large data sets. 
C) uses data to determine a course of action to be executed in a given situation. 
D) detects patterns in historical data and extrapolates them forward in time. 
Answer:  C 
Diff: 2 
Blooms:  Remember 
Topic:  Descriptive, Predictive, and Prescriptive Analytics 
LO1: Illustrate examples of descriptive, predictive, and prescriptive analytics. 
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Use the table below to answer the following question(s). 
 
Fiberia Accessories, a clothing retailer, is planning to introduce a new line of sweaters as part of 
the winter collection for $65 with an inventory of 1500. The main selling season is 60 days 
between November and December. The store then sells the remaining units in a clearance sale at 
65 percent discount. Out of the 60 main retail days, Fiberia sells the sweaters at full retail price 
for only 45 days, while giving a discount of 25 percent for the remaining 15 days. The demand 
functions a, and b are given as 79.5 and 1.1 respectively. 
 
Marked Down Pricing Model for  
Fiberia Accessories's new sweater  
  
Data  
  
Retail Price $65 
Inventory 1500 
Selling Season (days) 60 
Days at Full Retail 45 
Intermediate Markdown 25 percent 
Clearance Markdown 65 percent 
Demand Function  
A 79.5 
B 1.1 
 
31) What is the average daily sale during the full retail sales period? 
A) 15 
B) 33.33 
C) 8 
D) 24.55 
Answer:  C 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
 
 
32) Calculate the total number of units sold during the full retail sales period. 
A) 33.33 
B) 520 
C) 187.5 
D) 360 
Answer:  D 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
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Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
 
 
33) Calculate the total revenue during the full retail sales period. 
A) $23,400 
B) $16,200 
C) $2,880 
D) $17,550 
Answer:  A 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
 
 
34) Calculate the daily sales during the discount sales period. 
A) 39.28 
B) 133.3 
C) 388.13 
D) 25.88 
Answer:  D 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
 
 
35) Calculate the total units sold during the discount sales period. 
A) 388.13 
B) 25.88 
C) 133.3 
D) 39.28 
Answer:  A 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
 
 
36) Calculate the total revenue during the discount sales period. 
A) $4,478.91 
B) $18,921.09 
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C) $10,042.73 
D) $43,321.09 
Answer:  B 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
 
 
37) Calculate the revenue for the clearance sales period. 
A) $18,921.09 
B) $23,400 
C) $48,871.88 
D) $17,105.16 
Answer:  D 
Diff: 3 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
 
 
38) Calculate the total revenue for the new line of sweaters. 
A) $59,426.25 
B) $48,871.88 
C) $23,400 
D) $43,231.09 
Answer:  A 
Diff: 1 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
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Use the table below to answer the following question(s). 
 
In the spreadsheet below, there is data on the price, cost, demand, and quantity produced for an 
item. There are also different "what if" values that can help a manager to calculate costs and 
revenue with variability in demand. 
 
 A B C 
1 Profit Model   
2    

3 Data  
What-If Demand 
Values 

4   20,000 
5 Unit Price ($) 50 40,000 
6 Unit Cost ($) 25 55,000 
7 Fixed Cost ($) 550,000 60,000 
8 Demand 60,000 65,000 
9 Quantity Produced 55,000  
10    
 
39) Which of the following is the Excel formula to determine the number of units sold? 
A) =B8 
B) =MIN(0,B8,B9) 
C) =MIN(B8,B9) 
D) =MAX(0,B8,B9) 
Answer:  C 
Diff: 1 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
 
 
40) If D is demand, P is the unit price, and c and d are constants (where d > 0 is the price 
elasticity), which of the following is a nonlinear demand prediction model? 
A) D = d + (c × P) 
B) D = (d × P)c 
C) D = cd × P 
D) D = cP-d 
Answer:  D 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
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Use the chart below to answer the following two questions: 
 

 
 
41) What is the slope of the sales function D = a - bP? 
A) 4 
B) 9 
C) 12 
D) 17 
Answer:  C 
Diff: 3 
Blooms:  Apply 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
 
 
42) How many gallons will be sold if the price is increased to $4.75? 
A) 833.26 
B) 843 
C) 798.72 
D) 818 
Answer:  B 
Diff: 3 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Models in Business Analytics 
LO1:  Illustrate examples of descriptive, predictive, and prescriptive models. 
 
 
43) What does business analytics use to help managers make better decisions? 
A) data and information technology. 
B) statistical analysis and quantitative methods. 
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C) mathematical or computer-based models. 
D) all of the above. 
Answer:  D 
Diff: 1 
Blooms:  Remember 
Topic:  What is Business Analytics? 
LO1: Define business analytics.  
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Business Analytics (Evans) 
Chapter 1   Appendix A1 Basic Excel Skills 
 
1) Which of the following symbols is used to represent exponents in Excel? 
A) ^ 
B) * 
C) # 
D) ! 
Answer:  A 
Diff: 1 
Blooms:  Remember 
Topic:  Excel Formulas and Addressing 
LO1:  Find buttons and menus in the Excel 2010 ribbon. 
 
 
2) Which of the following ways would 102 × 53 / 100 - 73 be represented in an Excel 
spreadsheet? 
A) 10(2) * 5(3) / 100 ^ 73 
B) 10(2) ^ 5(3) / 100 - 73 
C) 10^2 * 5^3 / 100 - 73 
D) 10*2 ^ 5*3 / 100 - 73 
Answer:  C 
Diff: 1 
Blooms:  Understand 
Topic:  Excel Formulas and Addressing 
LO1:  Write correct formulas in an Excel worksheet. 
 
 
3) Which of the following is a difference between relative addressing and absolute addressing 
when using cell formulas in Excel? 
A) A relative address uses a dollar sign before either the row or column label; an absolute 
address uses the ampersand symbol before either the row or column label. 
B) A relative address uses a dollar sign before either the row or column label; an absolute 
address uses just the row and column label in the cell reference. 
C) A relative address uses just the row and column label in the cell reference; an absolute 
address uses a dollar sign before either the row or column label. 
D) A relative address uses only the column label in the cell reference; an absolute address uses 
the row. 
Answer:  C 
Diff: 2 
Blooms:  Remember 
Topic:  Excel Formulas and Addressing 
LO1:  Apply relative and absolute addressing in Excel formulas. 
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Use the data given below to answer the following question(s) 
 
Below is the spreadsheet for demand prediction of a company that sells chocolates. 
 

 

 
 
4) Given that D = a-bP, where D, is demand, "a" and "b," are linear constants, and P, is price, 
from the below spreadsheet, how will the formula in B9 be represented in Excel using relative 
addressing? 
A) B4-B5*A9 
B) C5-C6*A10 
C) B4-B5*A10 
D) B5-B6*A10 
Answer:  A 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Excel Formulas and Addressing 
LO1:  Copy formulas from one cell to another or to a range of cells. 
 
 
5) If a dollar sign is used after the column in B5 (B$5), how will the formula at B8 be 
represented in C9 using absolute addressing? 
A) C3-B$5*C9 
B) C5-C$6*B9 
C) C5-C$6*C9 
D) C5-C$5*B9 
Answer:  D 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Excel Formulas and Addressing 
LO1:  Apply relative and absolute addressing in Excel formulas. 

 A B C 

1 
Demand Prediction 
Models   

2    
3 Linear Model   
4 A 10,000  
5 B 10  
6    
7 Price Demand  
8 $50 9,500  
9 $55 9,450  
10 $45 9,550  
11    
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6) If a dollar sign is used before the column label B4 ($B4), how will the formula at B10 be 
represented in C11 using absolute addressing? 
A) $B5-C6*B11 
B) $C5-C6*A10 
C) $B4-C5*B11 
D) $A5-C6*B11 
Answer:  A 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Excel Formulas and Addressing 
LO1:  Apply relative and absolute addressing in Excel formulas. 
 
 
7) If, in the spreadsheet, cells B9 and B10 were empty, which of the following formulas should 
be entered in B8 so that the formula can be dragged to B9 and B10 to obtain their correct values? 
A) B4-B5*A8 
B) B4-B5*$A8 
C) $B4-B5*$A8 
D) $B$4-$B$5*$A8 
Answer:  D 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Excel Formulas and Addressing 
LO1:  Copy formulas from one cell to another or to a range of cells. 
 
 
8) Using a $ sign before a column label ________. 
A) keeps the reference to both the row and column fixed 
B) keeps the reference to the row fixed, but allows the column reference to change 
C) keeps the reference to column fixed, but allows the row reference to change 
D) allows both the row and column references to change 
Answer:  C 
Diff: 1 
Blooms:  Remember 
AACSB:  Analytic Skills 
Topic:  Excel Formulas and Addressing 
LO1:  Copy formulas from one cell to another or to a range of cells. 
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9) To copy a formula from a single cell or range of cells down a column or across a row, first 
________, click and hold the mouse on the small square in the lower right-hand corner of the 
cell, and drag the formula to the "target" cells which you wish to copy. 
A) press Ctrl-C 
B) select the cell or range 
C) press Ctrl-Enter 
D) select the whole spreadsheet 
Answer:  B 
Diff: 1 
Blooms:  Remember 
AACSB:  Analytic Skills 
Topic:  Excel Formulas and Addressing 
LO1:  Copy formulas from one cell to another or to a range of cells. 
 
 
10) Trace the process of copying and pasting a cell, which has a formula in it, such that the 
formula is not retained in the pasted cell. 
A) Home - Paste - Paste Special - Paste Values 
B) Home - Paste - Paste Special - Paste Validation 
C) Home - Paste - Paste Special - Paste Formats 
D) Home - Paste - Paste Special - Paste Formulas 
Answer:  A 
Diff: 1 
Blooms:  Remember 
Topic:  Miscellaneous Excel Functions and Tools 
LO1:  Copy formulas from one cell to another or to a range of cells. 
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Use the data given below to answer the following question(s). 
 
Below is a spreadsheet of purchase orders for a computer hardware retailer. 
 
 A B C D E F G H 

1 
Purchase 
Orders        

2         

3 Supplier 
Item 
Description 

Item 
Cost Quantity 

Cost per 
Order 

A/P Terms 
(Months) 

Order 
No. 

Order 
Size 

4 
Rex 
Technologies 

Graphics 
Card $ 89 35 $3115 20 AL123 Large 

5 
Rex 
Technologies Monitor $150 15 $2250 25 AL234 Small 

6 
Rex 
Technologies Keyboard $ 15 40 $600 15 AL345 Large 

7 
Rex 
Technologies Speakers $ 15 20 $300 25 AL456 Small 

8 
Max's 
Wavetech HD Cables $  5 10 $50 25 KO876 Small 

9 
Max's 
Wavetech Processor $278 27 $6950 30 KO765 Large 

10 
Max's 
Wavetech Hard disk $120 18 $2160 20 KO654 Small 

11         
12         
 
 
11) To find the total order cost, what Excel formula should be used in A12? 
A) =COUNT(C4:C10) 
B) =COUNT(C4:C7) 
C) =MAX(C4:C10) 
D) =SUM(E4:E10) 
Answer:  D 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Excel Functions 
LO1:  Use basic and advanced Excel functions. 
 
 
12) For which of the following columns can the COUNT function be performed? 
A) column G 
B) column E 
C) column B 
D) column A 
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Answer:  B 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Excel Functions 
LO1:  Use basic and advanced Excel functions. 
 
 
13) To find the average of the total cost of orders from Rex Technologies, what Excel formula 
should be used in A12? 
A) =AVERAGE(C4:C10) 
B) =AVERAGE(C4:C7) 
C) =AVERAGE(E4:E7) 
D) =AVERAGE(E4:E10) 
Answer:  C 
Diff: 2 
Blooms:  Apply 
AACSB:  Analytic Skills 
Topic:  Excel Functions 
LO1:  Use basic and advanced Excel functions. 
 
 
14) The easiest way to locate a particular function is to select a cell and click on the Insert 
function button represented by ________ on the Excel ribbon. 
A) fx 
B) Σ 
C) $ 
D) % 
Answer:  A 
Diff: 1 
Blooms:  Remember 
Topic:  Excel Functions 
LO1:  Find buttons and menus in the Excel 2010 ribbon. 
 
 
15) What is the Insert function in Excel? 
Answer:  The easiest way to locate a particular function is to select a cell and click on the Insert 
function button fx, which can be found under the ribbon next to the formula bar and also in the 
Function Library group in the Formulas tab. You may either type in a description in the search field, 
such as "net present value," or select a category, such as "Financial," from the drop-down box. This 
feature is particularly useful if you know what function to use but are not sure of what arguments to 
enter because it will guide you in entering the appropriate data for the function arguments. 
Diff: 1 
Blooms:  Remember 
Topic:  Excel Functions 
LO1:  Use basic and advanced Excel functions. 
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16) The Excel function of ________ is used to find the largest value in a range of cells. 
A) SUM(range) 
B) COUNT(range) 
C) MAX(range) 
D) COUNTIF(range, criteria) 
Answer:  C 
Diff: 1 
Blooms:  Remember 
Topic:  Excel Functions 
LO1:  Apply logical functions in Excel formulas. 
 
 
17) ________ measures the worth of a stream of cash flows, taking into account the time value 
of money. 
A) Accounting rate of return 
B) Net present value 
C) Internal rate of return 
D) Adjusted present value 
Answer:  B 
Diff: 1 
Blooms:  Remember 
Topic:  Excel Functions 
LO1:  Design simple Excel templates for descriptive analytics. 
 
 
18) The ________ reflects the opportunity costs of spending funds now versus achieving a return 
through another investment, as well as the risks associated with not receiving returns until a later 
time. 
A) modified internal rate of return 
B) payback period 
C) accounting rate of return 
D) discount rate 
Answer:  D 
Diff: 1 
Blooms:  Remember 
Topic:  Excel Functions 
LO1:  Design simple Excel templates for descriptive analytics. 
 
 
19) Identify the equation for calculating the net present value for a stated period of time, where 
Ft = cash flow in period t, and i is the discount rate. 

A) NPV = 0 2

n
t

t

F i

n
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B) NPV = 
0

(1 )
n

t
t

t
F i



   

C) NPV = 
0 (1 )

n
t

t
t

F
i    

D) NPV = 
0

(1 )
n

tt

t

F i
i

  

 
Answer:  C 
Diff: 1 
Blooms:  Remember 
Topic:  Excel Functions 
LO1:  Design simple Excel templates for descriptive analytics. 
 
 
20) A positive NPV means that the investment will provide added value because the projected 
return exceeds the ________. 
A) modified internal rate of return 
B) discount rate 
C) accounting rate of return 
D) adjusted present value 
Answer:  B 
Diff: 1 
Blooms:  Remember 
Topic:  Excel Functions 
LO1:  Design simple Excel templates for descriptive analytics. 
 
 
21) Describe the method of calculating the net present value (NPV) in Excel. 
Answer:  The Excel function NPV (rate, value1, value2,…) calculates the net present value of an 
investment by using a discount rate and a series of future payments (negative values) and income 
(positive values). Rate is the rate of discount over the length of one period (i), and value1, 
value2,… are 1 to 29 arguments representing the payments and income. The values must be 
equally spaced in time and are assumed to occur at the end of each period. The NPV investment 
begins one period before the date of the value1 cash flow and ends with the last cash flow in the 
list. The NPV calculation is based on future cash flows. If the first cash flow (such as an initial 
investment or fixed cost) occurs at the beginning of the first period, then it must be added to the 
NPV result and not included in the function arguments. 
Diff: 1 
Blooms:  Remember 
Topic:  Excel Template Design 
LO1:  Design simple Excel templates for descriptive analytics. 
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Business Analytics, 3e (Evans) 
Chapter 2:   Database Analytics 
 
1) What is a database? 
A) a structured collection of related files and data 
B) simply a collection of data 
C) a data file holding a single file 
D) flat files used to store data 
Answer:  A 
Diff: 1 
Blooms:  Remember 
Topic:  Data Sets and Databases 
LO1:  Explain the difference between a data set and a database and apply Excel range names in 
data files. 
 
 
2) In a database, information is stored and maintained in ________. 
A) fields 
B) measurements 
C) entities 
D) attributes 
Answer:  C 
Diff: 1 
Blooms:  Remember 
Topic:  Data Sets and Databases 
LO1:  Explain the difference between a data set and a database and apply Excel range names in 
data files. 
 
 
3) In a database file, which is organized in a two-dimensional table, the rows represent records of 
related data elements. 
Answer:  TRUE 
Diff: 1 
Blooms:  Remember 
Topic:  Data Sets and Databases 
LO1:  Explain the difference between a data set and a database and apply Excel range names in 
data files. 
 
 
4) The sort buttons in Excel can be found under: 
A) the Data tab in the Sort & Filter group. 
B) the Home tab in the Styles group. 
C) the Insert tab in the Sort group. 
D) the Sort tab in the Filter group. 
Answer:  A 
Diff: 1 
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Blooms:  Remember 
Topic:  Data Queries: Tables, Sorting, and Filtering 
LO1:  Construct Excel tables and be able to sort and filter data. 
 
 
Use the data given below to answer the following question. 
 
Following is the purchase order database of 'The Chef Says So', a restaurant in New York, over 
the last quarter (April-June). 
 

Order 
Date Item Region Supplier Unit Cost Units 

5/6/2012 Steel Fork Antasia Peter 5.44 98 
4/7/2012 Ceramic Plate Puitoria Kane 23.44 53 
5/13/2012 Steel Fork Puitoria Jones 8.44 39 
6/10/2012 Silver Spoon Puitoria Gerry 23.44 30 
6/22/2012 Steel Fork Almeco Sarah 6.44 59 
5/17/2012 Ceramic Plate Antasia Peter 8.44 63 
4/25/2012 Steel Fork Puitoria Audrey 5.44 78 
6/1/2012 Steel Fork Puitoria Jones 8.44 93 
4/2/2012 Steel Fork Almeco Thomas 5.44 35 
5/27/2012 Ceramic Plate Antasia Peter 12.44 63 
6/13/2012 Steel Fork Puitoria Mary 8.44 93 
4/30/2012 Ceramic Plate Antasia Henry 5.44 32 
5/11/2012 Ceramic Plate Antasia Philip 23.44 84 
6/18/2012 Steel Fork Antasia Peter 8.44 38 
5/9/2012 Glass Bottle Puitoria Simson 128.45 5 
5/30/2012 Ceramic Bowl Antasia Peter 19.44 19 
6/6/2012 Ceramic Plate Puitoria Mary 12.44 31 
4/3/2012 Silver Spoon Antasia Peter 12.44 67 
6/26/2012 Silver Spoon Antasia Philip 23.44 18 
4/23/2012 Ceramic Bowl Puitoria Kane 8.44 99 
4/29/2012 Steel Fork Puitoria Simson 4.74 70 
4/4/2012 Ceramic Bowl Antasia Philip 19.44 77 
6/15/2012 Ceramic Plate Puitoria Gerry 12.44 49 
6/25/2012 Ceramic Plate Puitoria Simson 18.45 90 
5/23/2012 Ceramic Plate Antasia Peter 8.44 7 
6/28/2012 Ceramic Plate Almeco Sarah 23.44 10 
5/25/2012 Ceramic Bowl Puitoria Jones 8.44 53 
5/1/2012 Steel Fork Puitoria Audrey 5.44 69 
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Order 
Date Item Region Supplier Unit Cost Units 

4/12/2012 Silver Spoon Antasia Henry 8.44 99 
4/18/2012 Steel Fork Puitoria Gerry 4.74 56 
6/30/2012 Ceramic Plate Puitoria Gerry 12.44 83 
5/19/2012 Glass Bottle Puitoria Kane 128.45 8 
4/16/2012 Ceramic Bowl Antasia Peter 8.44 65 
6/4/2012 Ceramic Bowl Puitoria Mary 15.94 58 
5/2/2012 Ceramic Bowl Puitoria Kane 27.4 45 
4/19/2012 Glass Bottle Almeco Sarah 278.45 6 
6/11/2012 Steel Fork Puitoria Gerry 4.74 10 
5/31/2012 Silver Spoon Almeco Sarah 5.44 79 
6/2/2012 Ceramic Plate Almeco Thomas 23.44 60 
4/13/2012 Steel Fork Puitoria Audrey 4.74 17 
5/3/2012 Ceramic Plate Puitoria Jones 8.44 14 
6/3/2012 Ceramic Plate Puitoria Jones 23.44 97 
4/17/2012 Ceramic Plate Puitoria Audrey 8.44 31 

 
 
5) Describe how to sort the data by inventory value to compute cumulative percentage of total 
inventory value to help the restaurateur conduct a Pareto analysis. (Assume that no damages 
were caused to the inventory purchased over the three months) 
Answer:   
In order to calculate inventory value of items, only Item, Unit Cost, and Units have to be retained 
in the table. Inventory value can be calculated by multiplying the unit cost by the number of 
units. Percentage and the cumulative percentage may be calculated based on the inventory 
values. Then, sort by Item, calculate subtotals for each Item, calculate percentages, sort the 
percentage in descending order and then calculate the cumulative percentages. 
 

Item Unit 
Cost Units Inventory 

Value Percentage Cumulative 
Percentage 

Steel Fork 5.44 98 533.12 1.77646 1.77646 
Ceramic Plate 23.44 53 1242.32 4.13966 5.91612 

Steel Fork 8.44 39 329.16 1.09683 7.01295 
Silver Spoon 23.44 30 703.2 2.3432 9.35616 

Steel Fork 6.44 59 379.96 1.2661 10.6223 
Ceramic Plate 8.44 63 531.72 1.7718 12.3941 

Steel Fork 5.44 78 424.32 1.41392 13.808 
Steel Fork 8.44 93 784.92 2.61551 16.4235 
Steel Fork 5.44 35 190.4 0.63445 17.0579 


